Ver 14.0

NetSim®

Accelerate Network R & D

Software Defined Networks

A Network Simulation & Emulation Software

By

N
TETC®S

LP

© TETCOS LLP. All rights reserved Page 1 of 32



Ver 14.0

The information contained in this document represents the current view of TETCOS LLP on the
issues discussed as of the date of publication. Because TETCOS LLP must respond to changing
market conditions, it should not be interpreted to be a commitment on the part of TETCOS LLP,
and TETCOS LLP cannot guarantee the accuracy of any information presented after the date of
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1 About SDN

The salient features of SDN are:

= Directly programmable: SDN decouples the network control and forwarding functions.
SDN allows programming the network control plane by abstracting the physical
infrastructure.

= Agile: Decoupling and abstracting network control from forwarding helps administrators
dynamically adjust network-wide traffic flow to meet the changing needs in the networks.

= Centrally managed: Network intelligence is centralized (logically) in software based SDN
controllers that maintain a global view of the network, which appear to applications and
policy engines as a single, logical switch.

= Programmatically configured: SDN lets network managers configure, manage, secure,
and optimize network resources very quickly via dynamic, automated SDN programs, which
they can write easily and quickly, because the programs do not depend on proprietary
software.

» Open standards-based and vendor-neutral: Because SDN is implemented through open
standards, SDN simplifies network design and operation because instructions are provided

by SDN controllers instead of multiple, vendor-specific devices and protocols.
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2 SDN In NetSim

SDN is available in NetSim from version 11 onwards. NetSim 'simulates’ OpenFlow protocol.
OpenFlow is an open interface to remotely control the forwarding tables in network switches,

routers, etc.
2.1 SDN Controller in NetSim

An SDN controller is an application in SDN that manages flow control to enable intelligent
networking. SDN controller can be used to control the packet forwarding of all Layer 3 devices in
the network.

SDN controller lies between the network devices and the applications. Any communication

between applications and devices must go through the controller.

NetSim has inbuilt controllers that 'simulate’ SDN. An SDN controller in NetSim contains a
Command Line Interface (CLI) to allow you to configure properties, such as, the IP forwarding

table for different devices in the network.

NetSim also provides a platform whereby users can develop various kind of commands/interface

compatible to any SDN enabled device.

In NetSim, any Layer 3 device can be configured as an SDN Controller. Multiple controllers can
be configured in a network scenario. The following is a list of Layer 3 devices you can configure

as an SDN controller:

» Internetworks — Nodes (Wired, Wireless Node), L3 Switches, Routers

= MANETs — Nodes (Wired, Wireless Node), Bridge Node (Wired, Wireless Node), Routers
= WSN - Sensors and Sink Node

= |OT - Sensors and Gateway (LowPAN Gateway), Nodes (Wired, Wireless Node), Routers
= Cognitive Radio — CR CPE, Nodes (Wired, Wireless Node), Routers

= LTE - UE, EPC, Nodes (Wired, Wireless Node), Routers

» VANETSs - Vehicle and RSU

= 5G mmWave — UE, EPC, Nodes (Wired, Wireless Node), Routers

NOTE: NetSim ‘simulates’ SDN protocol and cannot connect to real controllers such as Open Daylight.
2.2 CLI Commands for SDN in NetSim

You can use the following commands when you simulate SDN in NetSim:

Simulation-specific — Pause, PauseAt, Continue, Stop, Exit, and Reconnect.

Route — route add, route print, and route delete.
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Ping Command - ping (not supported on some network types, for example, Wireless Sensor
Network)
ACL configuration — ACL Enable, ACL Disable, ACL Print, and aclconfig.

Notes: CLI commands in NetSim are NOT case-sensitive. To get detailed help about how to use
CLI commands in NetSim, see Section 3.5 NetSim Interactive Simulation in User Manual.

2.3 Configuring SDN in NetSim

SDN protocol parameters can be accessed and configured from the Application layer properties
of the devices.

¢ Open-flow protocol must be enabled in the devices which are configured as SDN Controller
or SDN clients.

¢ SDN Controller device must have the SDN Controller option set to True.

e SDN Client devices must have the SDN Controller option set to False along with the

Controller Device Name set as the SDN Controller Device Name.
e TCP protocol must be enabled in the SDN Controller and client devices.

¢ Interactive Simulation option needs to be set to True in the Run time interaction tab that is

part of the Run Simulation window.

When SDN commands are executed during runtime either via console or via file input, commands

and response are exchanged between the controller and clients using TCP
2.4 How to use CLI Commands for SDN

Each device in NetSim has a console which can be accessed by right clicking on the device.
Users can execute supported SDN commands on the console of the SDN controller node to
configure other nodes in the network. Let us look at a few examples.

Example 1: To view the IP routing table of a node that is controlled by the SDN controller, use

the following command syntax: <DeviceName with Device_ID> route print.
For example, type Wired_Node_2 route print and press Enter.

The following image illustrates the output for the command.
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B " C\Program Files\NetS dard_v14_D\bin\NetSimCLl.exe

Figure 2-1: Printing IP routing table in Console

Example 2: To initiate ping from one node to another node where both nodes are controlled by
the SDN controller, following command can be executed in the SDN controller:
<DeviceName with Device_ID> Ping <DeviceName with Device_ID> or <DeviceName with

Device_ID> Ping <IP Address>.

For example, type Router_4 ping Router_5 or Router_4 ping 11.1.1.2 and press Enter.
B C\Program Files\NetSim Pro‘\bin\NetSimCLI.exe - O b

Initialising | .Initi:
DESKTOP

Figure 2-2: Pinging Router_4
NOTE: In order to initiate ping between the devices, ICMP protocol which is present in the Network Layer

properties of the devices must be set to TRUE.
2.5 Excluded Features

Multiple controllers can be configured in NetSim. However, intercontroller communication requires

the user to write their own code in NetSim.
2.6 Troubleshooting issues in executing SDN commands

When executing SDN commands in the SDN controller, there can be cases where there is no

response coming back. Some of the reasons for this are listed below:
e SDN Controller and SDN client are unable to communicate (not reachable).

o Part of two different networks
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o Due to the distance between the devices in the case of wireless nodes
e Failed TCP connection attempts due to high error or collision

o Commands for Controller to the client and response from the client to the controller are
passed as TCP packets.

o The TCP connection attempt fails if the maximum connection attempt is reached.
¢ High network traffic due to application packets exchanged during the simulation
Some suggestions to resolve issues with SDN command execution are listed below:
e Connectivity between the SDN controller and clients should be ensured.

e Application start time can be increased to allow necessary SDN commands to be executed
prior to application traffic flow which will also avoid contention especially in the case of

Wireless devices.

¢ SDN commands can be passed as input via file-based interactive simulation for higher

accuracy in terms of the time at which the commands are to be executed.
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3 Featured Examples

NetSim provides inbuilt examples to get started with the SDN module. To access these examples,
you can go to Examples > Software-Defined-Networks in the NetSim Home Screen. You can
change the default values of the parameters in these examples and see how they affect the
performance of the SDN network.

3.1 Configuring SDN

3.1.1 Configuring One SDN Controller in a Simple
Internetwork

The Internetwork model in this example consists of the following configuration:

1. A subnet with 2 wired nodes, 3 routers, and a unicast application running on one of the wired
nodes.

Only one router is configured as the SDN controller.

Open Flow protocol is enabled on all wired nodes and routers.

A unicast application is set between Wired_Node 1 to Wired_Node_ 2.

Set Transport Protocol to TCP in Application icon present in the top ribbon/toolbar.

Simulation time is set to 500 seconds.

No g bk DN

Plots, Packet trace, and Event trace logs are enabled.
To simulate the example for One SDN controller in an Internetwork:
Open NetSim and Select Examples > Software Defined Networks > Configuring SDN > SDN

Internetworks then click on the tile in the middle panel to load the example as shown in below
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[ e 5

NetSim Professional

Network Simulation/Emulation Platform
Version 14,0.27 (64 Bif)

New Simulation Ctri=N  Example Simulations SDN Intemetworks Results

Your Work crko Intemetworks A simple example with involing one SDN controller, This example is developed in the internetworks library,

|Examples Cellular Networks P -

i
\ = o4
I Advanced Routing =
Experiments b Mobile Adhoc Networks. AANN
4 Software Defined Networks Enabled open fiow in al devices 4 T |
Changed SDN controller device name ¥ 5
i

£

quring { e e
4 Configuring SDN Transpart protaccl: TCP 8/ 2 b
SDN Internetworks J

Rodter 3 )
WSN Setting Multiple SDN Controllers T Rouger S
MANET StaticRoute 1 2
Intemetworks StaticRoute —
App1 CER
WSN StaticRoute

Wired_Node_1 2
o | Node_ Wired_Node_2
Cagnitive Radia Netwarks

LTE and LTE-A
VANETs

Satellite Communication i

Device Name  Open_Flow SON_Controller  SON_Contralier_DeviceName
5GNR
Wred Nose 1 | Enatle FALSE SOM_Contoter
TDMA Radio Networks
Rowter 3 Enatie FALSE SOM_Conuroter
License Settings
SON_Conioter | Enatie TRUE N
Exit Alt=F4 Router 5 Enatie FALSE SON_Controter
Weed_Node 2 | Enatle FaLsE SON_Contoter
Ready to simulate scenarios to understand the working of the different technology libraries in NetSim. Expand and click on the file name to display simulation examples. Then click on a tile in the middle panel to load the simulation. Click on the book icon on
the left (Example Simulations) panel to view documentation (pe).

Support Leam Documentation Contact Us
FAQ Email - sales@tetcos.com
Phone - +01 767 605 4321
Website: o

Figure 3-1: List of scenarios for the example of SDN Internetworks

The following network diagram illustrates what the NetSim Ul displays when you open the

example configuration file for SDN as shown Figure 3-2.

-
App1_CBR

Wired_Node_1 ‘Wired_Node_2

Figure 3-2: Network set up for studying the SDN Internetworks
1. In the application layer of the SDN Controller node:

a. SDN_Controller option set to TRUE.

b. Open_Flow protocol is enabled.

The following image illustrates the settings done in the SDN controller device:
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m SDN_Controller Properties - X

SANO B

L

& General
& Position

4 Application Layer

4 QOpen Flow

Open Flow Enable TRUE A
SDN Controller TRUE v
> OSPF

Transport Layer

B

> Network Layer
> Interface_1 (WAN)
B

Interface_2 (WAN)

Figure 3-3: Application Layer properties Window of SDN_Controller device
2. In the other devices (Routers and wired node) that are part of the network,
SDN_Controller option is set to FALSE.
b. SDN_Controller_DeviceName is set as “SDN_Controller” which is the name of the
controller node.

c. Open_Flow protocol is enabled.

The following image illustrates settings done in the other devices:

EEWirediodej Properties — X

AN O B

L

B General
& Position

4 Application Layer

4 Open Flow

Open Flow Enable TRUE h
SDN Controller FALSE h
SDN Controller Device Name SDN_Controller

&> Transport Layer
& Network Layer
I Interface_1 (Ethernet)

Figure 3-4: SDN_Controller_DeviceName is set as SDN_Controller in Application layer

The following table lists the settings done in all the devices that are part of the network:

Device Name Open_Flow SDN_Controller SDN_Controller_DeviceName
Wired Node 1 Enable FALSE SDN_ Controller

Router_3 Enable FALSE SDN_Controller
SDN_Controller  Enable TRUE NA

Router 5 Enable FALSE SDN_Controller
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Wired_Node_2 Enable FALSE SDN_Controller

Table 3-1: Set the properties for all the devices
3. Click on the Application icon present in the top ribbon/toolbar.

a. CBR Application from Wired Node 1 to Wired Node 2 with 50 Mbps Generation Rate
(Packet Size: 1460Bytes, Inter Arrival Time: 233.6us).
b. Set Transport Protocol to TCP.

4. Before simulating the example, Right-click SDN_Controller and select NetSim Console. Now,
the client (NetSimCLI.exe) waits to establish a connection with NetSimCore.exe as shown

below.

B ChProgram Files\MetSim ProtbiniMetSimCLILexe

MNetSim:

Figure 3-5: Connection Establishment

5. Follow the below steps to simulate an example.

a. Click on the Options tab. Select Run time interaction.

ﬁ File Options Help | Network: Internetworks | Workspace: 30ct2023

M Create| Open MATLAB Interface 11l Configure Reports % Show/Hide Info

Run Time Interaction I
@ Save Static ARP Wired Node =3 L2 Switch @ uc\
. ® e
(:—:I Close N\ E Wireless Node L3 Switch °

File Run Simulation Node Switch Access Point Router Wired/Wireless Links

1t

%)

Figure 3-6: Run Time Interaction option in NetSim GUI

b. Inthe Run Time Interaction tab, set Interactive Simulation to True and click on OK.

E Runtime Interaction - O X

NetSim allows users to interact with simulations at runtime via command execution to
view/modify certain device parameters during runtime.

There are two options available for runtime interaction. Interaction can be set to be via a
socket or through a 'input.txt’ file in a predefined format.

This input.txt file accepts all the commands that NetSim's interactive simulation supports.

Interactive Simulation True v

File Name Input File Browse

OK Cancel

Figure 3-7: Enable Interactive Simulation
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c. Click on Run Simulation window and simulate it to 500 secs.

-TA NetSim - Run Simulation - X

Simulation Time
Enter desired simulation time. Valid range is 0.0001 to 100,000 seconds.
Simulation Time | 50

Seed Value

Enter seed value between 1 to 99,999,999. The seed values are used to generate random
numbers in simulation.

Seed 1 | 12345678 Seed 2 23456789

Run Cancel

Figure 3-8: Run Simulation Window
Simulation (NetSimCore.exe) starts to run. NetSimCore.exe displays the following message:

waiting for the first client to connect.

B! C:\Users\User\OneDrive\OneDrivestore\OneDrive\Documents\NetSim\Workspaces\3Oct2023\bin_x64\NetSimCore.exe — O X

NetSim License Manager will first check for node lock licenses.

If not available, it will then check for floating/cloud licenses

NetSim License Manager Start. Checking for licenses available (this may take upto 2 min) -
No license for product (-1)

NetSim License Manager Start. Checking for licenses available (this may take upto 2 min) -

License Manager Output. Product>Edition>Maj_ver>Min_ver>Lic_type>Components>

netsim>std>14>6>rlm_hw>111111111111510108>

NetworkStack loaded from path- C:\Users\User\OneDrive\OneDrivestore\OneDrive\Documents\NetSim\Workspaces\30ct2623\bin_x§
4/NetworkStack.d1l

NetSim start

Network Stack loaded

Error in creating C:\Users\User\AppData\Local\Temp\NetSim\std_14.6\/log directory. Error number 17
Initializing simulation

Config file reading complete

License re-validation complete

Protocol binaries loaded

Executing command --- DEL "C:\Users\User\AppData\lLocal\Temp\NetSim\std_14.@\\*.pcap"”
Could Not Find C:\Users\User\AppData\Local\Temp\NetSim\std_14.6\*.pcap

Emulation is disabled

Stack variables initialized

[Could Not Find C:\Users\User\AppData\Local\Temp\NetSim\std_14.6\Plot_*

Metrics variables initialized

Protocol variables initialized

NetSim Console Mode is enabled.

Waiting for first client to connect. Press ctrl+c to stop connection.

Figure 3-9: Waiting for first client to connect.
d. Use this console to execute SDN commands as explained in section Error! Reference

source not found.
3.1.2 Configuring Multiple SDN Controllers in a Wireless
Sensor Network

In this example, multiple SDN controllers are configured in a Wireless Sensor Network.
The Wireless Sensor Network model in this example consists of the following configuration:
= A subnet with 4 wireless sensors,1 ad-hoc link, 1 WSN sink node, and a unicast sensor

application running on one of the wireless sensors.
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= Set Transport Protocol to TCP in Application icon present in the top ribbon/toolbar.

= Two wireless sensors are configured as SDN controllers.

= Open Flow protocol is enabled on all wireless sensors and sink node.

NetSim uses the following defaults for this SDN example:

a.

b.
c.

The unicast application transmits data from Wireless Sensor_3 to Wireless

Sensor_5.

Simulation runs for 500 seconds.

Plots, Packet trace, and Event trace is enabled.

NOTE: For aWSN network, ping command is not supported on ZigBee device since these nodes do not support

ICMP protocol.
To simulate the example for multiple SDN controllers in WSN for SDN:

Open NetSim and Select Examples > Software Defined Networks > Configuring SDN > WSN

Setting Multiple SDN Controllers then click on the tile in the middle panel to load the example

as shown in below screenshot

[ NetSim Home

NetSim Professional

Network Simulation/Emulation Platform

Version 14.0.27 (64 Bit)

New Simulation Ctri+N  Example Simulations
Your Work Ctie0 Internetworks
| Exsmples Cellular Networks

Experiments

License Settings

Exit Alt+F4

Support

Advanced Routing
Mobile Adhoc Networks

4 Software Defined Netwarks

4 Configuring SDN
DA Interne

WSN Setting Multiple SDN Controllers
TEhcHoute

Foul

Internetworks StaticRoute
WSN SteticRoute
IOT-WSN

Cogritive Radio Netwarks
LTE ang LTE-A

VANETs

Satellite Communication
SGNR &

TDMA Radio Networks

Leam

WSN Setting Multiple SDN Controllers

Simulating multiple SDN controllers. This example is devloped for Wireless Sensor Networks

WSN Setting Multiple SON Controllers.

Enabled open flow in
Changed SON controller device n:
Network layer protocok DSR
Interactive simulation: TRUE

Results

Contact Us

Email - sales@tetcos.com
Phene - <81 767 605 4221
Website : teos.com

Figure 3-10: List of scenarios for the example of WSN Setting Multiple SDN Controllers

Ready to simulate scenarios to understand the working of the different technology libraries in NetSim. Expand and click on the file name to display simulation examples. Then click on a tile in the middle panel to load the simulation. Click on the book icon on
the left (Example Simulations) panel to view documentation (pdf).

The following network diagram illustrates the network setup related to this example as shown

below Figure 3-11.

© TETCOS LLP. Allrights reserved
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SDN_(omr?ner_Sens R BRI -7 SDN_Controller_Sens
or 1 R - 1 or2

L SDN_Controller_Sink Tl
= 3 Node S~ 5

Jﬁ/\ﬁ)\ fppLSENSOR,APP ‘5@

Wireless_Sensor_3 Wireless_Sensor_5

Figure 3-11: Network set up for studying the WSN Setting Multiple SDN Controllers

1. The sensors 1, 2 and the sinknode are configured as SDN controllers with Open Flow
protocol enabled in all the nodes.

The following image illustrates the settings done in the sensors configured as SDN controller
as shown below Figure 3-12.

I_»r SDN_Controller_SinkNode Properties — X

AN O =

- General
& Position

4 Application Layer
4 Open Flow

Open Flow Enable TRUE v
SDN Controller TRUE v

B> Transport Layer
> Network Layer
B> Interface 1 (Zigbee)

Figure 3-12: Application Layer properties Window
2. The sensor SDN_Controller_Sensor_1 is set as the SDN controller for Wireless_Sensor_3

and SDN_Controller_Sensor_2 is set as the SDN controller for Wireless_Sensor_5.

The following image illustrates the settings done in sensor 3 as shown Figure 3-13.
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DE SDN_Controller_SinkNode Properties — X

AN O WA

& General
& Position

4 Application Layer
4 Open Flow

Open Flow Enable TRUE v
SDN Controller TRUE -

B> Transport Layer
> Network Layer
I Interface 1 (Zigbee)

Figure 3-13: SDN_Controller_DeviceName is set as SDN_Controller in Application layer

The following table lists the default setting for the wireless sensors.

Device Name Open_Flow SDN_Controller  SDN_Controller_DeviceName
SDN_Controller_Sensorl = Enable TRUE NA

SDN_Controller_Sensor2 | Enable TRUE NA

Wireless_Sensor_3 Enable FALSE SDN_Controller_Sensorl
Wireless_Sensor_5 Enable FALSE SDN_Controller_Sensor2

Table 3-2: Set the properties for all the devices

3. Click on the Application icon present in the top ribbon/toolbar.

a. Sensor Application from Wireless_Sensor_3 to Wireless_Sensor_5 with Packet Size:
50Bytes, Inter Arrival Time: 1000000us).
b. Set Transport Protocol to TCP.

4. Additional analysis options such as plots, packet trace and event trace are enabled.
5. Simulate the example. To do so:

Click the Run button. The Run Simulation pop-up window appeatrs.
Simulation time is set to 500 seconds.

In the Run time Interaction tab, Interactive Simulation option is set to True.
Click Accept.

Click OK.

® 2 0o T 9

Simulation (NetSimCore.exe) starts to run. NetSimCore.exe displays the following message:

waiting for the first client to connect.
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B Ch\Users\Hanuman\Documents\NetSim\Workspaces\default_std\bin_x64\NetSimCore.exe

Bir build date is "Dec 2 2021.

pto 2 min) -

| 11111111171

om path man\Docume

numan\A y. Error number 17

std_13.1\Plot_*

nimation_*

Figure 3-14: Waiting for first client to connect
6. To use the SDN CLI Console:
a. Right-click SDN_Controller_Sensorl or SDN_Controller_Sensor2 and click NetSim

Console. Now, the client (NetSimCLIl.exe) starts and tries to establish a connection with
NetSimCore.exe.

The following image illustrates the NetSim CLI console.

B | C\Program Files\NetSim\Standard_v14_0\bin\...

Initialising Winsock...Initialised.
Connecting to device DESKTOP-0@MSHL3.

Connection attempt: 4

Figure 3-15: Connection established.

7. Simulate the example. To do so:
a. Click on the Options tab. Select Run time interaction.

E File  Options Help | Network: Internetworks | Workspace: 30ct2023

J& Create| Open MATLAB Interface 1l Configure Reports 25l Showy/Hide Info

Run Time Interaction

O | . - | .
B Save ctatic ARP Wired Node 3 L2 Switch > O\
% (3 :

NS
ﬂ Close Wireless Node L3 Switch

1)

€3

File Run Simulation Node Switch Access Point Router Wired/Wireless Links

Figure 3-16: Run Time Interaction in NetSim GUI

b. In the Run time Interaction tab, Interactive Simulation option is set to True and click on

OK.
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NetSim allows users to interact with simulations at runtime via command execution to
view/modify certain device parameters during runtime.

There are two options available for runtime interaction. Interaction can be set to be via a
socket or through a ‘input.txt’ file in a predefined format.

This input.txt file accepts all the commands that NetSim's interactive simulation supports.

Interactive Simulation True v

File Name np

OK Cancel

Figure 3-17: Runtime Interaction window

c. Click on the Run Simulation window and simulate it to 500 sec.

NetSim - Run Simulation - X

Simulation Time

Enter desired simulation time. Valid range is 0.0001 to 100,000 seconds.

Simulation Time | 50|

Seed Value

Enter seed value between 1 to 99,999,999. The seed values are used to generate random
numbers in simulation

Seed 1 12345678 Seed 2 23456789

Run Cancel

Figure 3-18: Run Simulation Window

Ver 14.0

B | C\Users\User\OneDrive\OneDrivestore\OneDrive\Documents\NetSim\Workspaces\30ct2023\bin_x64\NetSimCore.exe

NetSim License Manager will first check for node lock licenses.

If not available, it will then check for floating/cloud licenses

[NetSim License Manager Start. Checking for licenses available (this may take upto 2 min) -
No license for product (-1)

[NetSim License Manager Start. Checking for licenses available (this may take upto 2 min) -

License Manager Output. Product>Edition>Maj_ver>Min_ver>Lic_type>Components>
netsim>std>14>0>rlm_hw>111111111111>16160>

[NetworkStack loaded from path- C:\Users\User\OneDrive\OneDrivestore\OneDrive\Documents\NetSim\Workspaces\30ct2023\bin_x

4/NetworkStack.dll

ook
NetSim start

[Network Stack loaded

Error in creating C:\Users\User\AppData\Local\Temp\NetSim\std_14.8\/log directory. Error number 17
Initializing simulation

Config file reading complete

License re-validation complete

Protocol binaries loaded

Executing command --- DEL "C:\Users\User\AppData\lLocal\Temp\NetSim\std_14.8\\*.pcap"

Could Not Find C:\Users\User\AppData\Local\Temp\NetSim\std_14.6\*.pcap

Emulation is disabled

Stack variables initialized

Could Not Find C:\Users\User\AppData\Local\Temp\NetSim\std_14.@\Plot_*

Metrics variables initialized

Protocol variables initialized

NetSim Console Mode is enabled.

Waiting for first client to connect. Press ctrl+c to stop connection.

Figure 3-19: Waiting for first Client to Connect

You can execute various SDN commands that are supported in any of the SDN controller Sensor

CLI.

© TETCOS LLP. Allrights reserved
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3.2 Configuring Static Routes for a MANET Network by using
SDN

In this example static routes are configured using the SDN controllers, in a MANET network.
The MANET network model in this example consists of the following configuration:
= A subnet with 5 wireless nodes and 1 ad-hoc link, and a unicast CBR application running
on one of the wireless nodes.
= DSR is the routing protocol that is enabled on all wireless nodes.
»= One wireless node is configured as the SDN controller.
= Wireless nodes do not have mobility.
= A unicast application is configured from Wireless_Node_1 to Wireless_Node_5.
= Simulation time is set to 1000 seconds.
= Packet trace, and Event trace is enabled.
To simulate the example for MANET using SDN:
Open NetSim and Select Examples > Software Defined Networks > MANET StaticRoute then

click on the tile in the middle panel to load the example as shown in below screenshot

(]

NetSim Professional
Network Simulation/Emulation Platform
Version 14,027 (64 Bit}

New Simulstion Ctd=N  Example Simulations MANET StaticRoute Results
Your Work o0 Intemetworks I this example, static routes are configured using the SDN controllers, in 3 MANET network.
Cellular Networks

MANET StaticRoute

Advanced Routing
Mobile Adhoc Networks
4 | Software Defined Networks
4 Configuring SDN

SDN Internetworks

Iy Setting Muitiple SON Controllers
MANET StaticRoute

Intemnetworks StaticRoute

)
Examples ke
b
b

Experiments

WSN StaticRoute A

b IOT-WSN hipd

I Cogritive Radio Networks

b7 LTE and LTE-A Type the following commands on the NetSim CLI
b 1 VANETs console, in the <Device name with Device_Id> route add
b ¥ Satelite Communication <destination IP address>MASK <subnet mask>
| semm <gateway IP address> <metric> if <interface#t> format
» B TOMA Radio Networks Wireless_Node_1 route add 11.1.1.5 mask 255.255.0.0

11.1.1.2 metric 1 if 1
License Settings

Wireless_Node_2 route add 11.1.1.5 mask 255.255.0.0
Exit AlteF4 11.1.1.3 metric 1if 1

Wireless_Node_3 route add 11.1.1.5 mask 255.255.0.0
1.1.1.4 metric 1 if 1

SDN_Controller route add 11.1.1.5 mask 255.255.0.0
11.1.1.5 metric 11

Ready to simulate scenarios ta understand the working of the different technology libraries in NetSim. Expand and click on the file name to display simulation examples. Then click on a tile in the middle panel to load the simulation. Click on the book icon on
the left (Example Simulations) panel to view documentation (pdf).

Support Learn Documentation Contact Us

Phone - +91 767 605 4321
Website

Figure 3-20: List of scenarios for the example of MANET StaticRoute

The following network diagram illustrates the network setup as shown Figure 3-21.
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Wireless Node_3
)
a2
. & 4
e e =]
R . ¥ =
! '//-/zfﬁ,;;‘;“ ! T
Wireless_Node_2 SRS T 7= ~-____ SDN_Controller
PR e Link_1 B
al -7 1 1 i e a5
Y - . -
Wireless Node_t Wireless_Node_5

Figure 3-21: Network set up for studying the MANET StaticRoute

1. DSR routing protocol is configured in Network layer for all the nodes and set the nodes to
be stationary.
2. Mobility model is set to NO_MOBILITY in all the nodes.
3. ICMP protocol is enabled in the network layer properties of all the wireless nodes.
4. Open flow protocol is enabled in all the wireless nodes.
The following settings were done in the wireless nodes to configure Wireless Node 4 as SDN

controller and other nodes as its clients.

Device Name Open_Flow SDN_Controller = SDN_Controller_DeviceName
Wireless Node 1 = Enable FALSE SDN_Controller
Wireless_Node 2 | Enable FALSE SDN_Controller

Wireless_ Node 3  Enable FALSE SDN_Controller
SDN_Controller Enable TRUE FALSE

Wireless Node 5  Enable FALSE SDN_Controller

Table 3-3: Set the properties for all the devices
1. Click on the Application icon present in the top ribbon/toolbar.
a. CBR Application from Wireless_Node_1 to Wireless_Node_5 with 0.584 Mbps Generation
Rate (Packet Size: 1460Bytes, Inter Arrival Time: 20000us).
b. Set Transport Protocol to UDP.

2. Channel Characteristics: Path Loss Only, Path Loss Model: Log Distance, Path Loss
Exponent:3.2.
In NetSim GUI Plots, Packet Trace and Event Trace are enabled.

Simulate the example. To do so:

Click the Run button. The Run Simulation pop-up window appeatrs.
Simulation time is set to 1000 seconds.

In the Run time Interaction tab, the Interactive Simulation option is set to True.
Click Accept.

Click OK.

® 2 0 T 9

Simulation (NetSimCore.exe) starts to run. NetSimCore.exe displays the following message:

waiting for first client to connect.
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5. To use the SDN CLI Console:

a. Right-click SDN Controller and select NetSim Console. Now, the client (NetSimCLIl.exe)
starts and attempts to establish a connection with NetSimCore.exe.

6. Simulate the example. To do so:

a. Click on the Options tab. Select Run time interaction.

Options  Help | Network: Internetworks | Workspace: 30ct2023

3¢ Create| Open MATLAB Interface

Run Time Interaction

B Save ["Static ARP

11l Configure Reports 2 Show/Hide Info

Wired Nod T2 L2 Switch
ired Node C witc @ af\
v H}ooowt ~
(—D Close N\ g Wireless Node @: L3 Switch - »

File Run Simulation

Node Switch Access Point Router Wired/Wireless Links

Figure 3-22: Runtime Interaction in GUI

b. In the Run time Interaction tab, Interactive Simulation option is set to True and click on

OK.

File Name

Ei Runtime Interaction — O %

NetSim allows users to interact with simulations at runtime via command execution to
view/modify certain device parameters during runtime.

There are two options available for runtime interaction. Interaction can be set to be via a
socket or through a ‘input.txt’ file in a predefined format.

This input.txt file accepts all the commands that NetSim's interactive simulation supports.

Interactive Simulation True -

Input File Browse

QK Cancel

Figure 3-23: Enabling Run Time Interaction option.

c. Click on Run simulation window and simulate it to 500 sec.

Seed Value

Ei NetSim - Run Simulation _ %

Simulation Time

Enter desired simulation time. Valid range is 0.0001 to 100,000 seconds.

Simulation Time | 500

Enter seed value between 1 to 99,999,999. The seed values are used to generate random
numbers in simulation

Seed 1 | 12345678 Seed 2 | 23456789

Run Cancel

Figure 3-24: Run Simulation window
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Simulation (NetSimCore.exe) starts to run. NetSimCore.exe displays the following message:

waiting for the first client to connect.

B! C:\Users\User\OneDrive\OneDrivestore\OneDrive\Documents\NetSim\Workspaces\30 ct2023\bin_x64\NetSimCore.exe - [m] X

[NetSim License Manager will first check for node lock licenses.

If not available, it will then check for floating/cloud licenses

[NetSim License Manager Start. Checking for licenses available (this may take upto 2 min) -
No license for product (-1)

[NetSim License Manager Start. Checking for licenses available (this may take upto 2 min) -

License Manager Output. Product>Edition>Maj_ver>Min_ver>Lic_type>Components>

netsim>std>14>0>rlm_hw>111111111111>10100>

[NetworkStack loaded from path- C:\Users\User\OneDrive\OneDrivestore\OneDrive\Documents\NetSim\Workspaces\30ct2023\bin_x§
4/NetworkStack.dll

ok
NetSim start

[Network Stack loaded

Error in creating C:\Users\User\AppData\Local\Temp\NetSim\std_14.0\/log directory. Error number 17
Initializing simulation

Config file reading complete

License re-validation complete

Protocol binaries loaded

Executing command --- DEL "C:\Users\User\AppData\Local\Temp\NetSim\std_14.@\\*.pcap"

Could Not Find C:\Users\User\AppData\Local\Temp\NetSim\std_14.@\*.pcap

Emulation is disabled

Stack variables initialized

Could Not Find C:\Users\User\AppData\lLocal\Temp\NetSim\std_14.@\Plot_*

Metrics variables initialized

Protocol variables initialized

NetSim Console Mode is enabled.

Waiting for first client to connect. Press ctrl+c to stop connection.

Figure 3-25: Waiting for the first Client to connect.

7. Interpret the Results

a. In the simulation results window select the Open Packet trace option in the left area. Once
the packet trace opens apply filter in the CONTROL_PACKET_TYPE/APP_NAME for
APP1_CBR.

b. The packets reach Wireless Node 5 from Wireless Node 1-> Wireless_Node 3->

Wireless_Node_5.

PACKET_ID|-¥|SEGMENT_ID| ~ |PACKET_TYPE ~ | CONTROL_PACKET_TYPE/APP_NAME -¥ SOURCE_ID ~ |DESTINATION_ID ~ | TRANSMITTER_ID| - |RECEIVER_ID ~
1 0 CBR Appl_CBR NODE-1 NODE-5 NODE-1 NODE-3
1 0 CBR Appl_CBR NODE-1 NODE-5 NODE-3 NODE-5

Figure 3-26 : Packet trace screenshot

8. For the same example, configure static routes such that the packets will go through
Wireless Node 1 > Wireless Node 2, Wireless Node 3, SDN_Controller to

Wireless_Node_5. To configure the static routes on SDN_Controller for all the nodes.

a. Right-click SDN_Controller and select NetSim Console.

b. Re- run the simulation.

c. Type the following commands on the NetSim CLI console, in the <DeviceName with
Device_ID> route add <destination IP address> MASK <subnet mask> <gateway IP

address> <metric> if <interface #> format.
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B ' C:\Program Files\NetSim\Standard_v14_0\bin\NetSimCLl.exe

Initialising Winsock...Initialised.
Connecting to devi OP-0@MSHL3.

Connection attempt: 2
Connection established.

eless_Node_1 route ADD 192.168.0.6 MASK 2

validated

command to client device 1

NetSim>Wireless_Node_2 route ADD 192.168.0.6 MASK

Input is validated

Sending command to client device 2

OK !

NetSim>Wireless_Node_3 route ADD 192

Input is validated

Sending command to client device 3

OK !

.168.0.6 MASK

255.255

255.255

192.168.0.4 METRIC 1 IF 1

192.168.0.5 METRIC 1 IF 1

255.255.255 192.168.8.3 METRIC 1 IF 1

NetSim>SDN_Controller route ADD 192.168.0.6 MASK 255.255.255.255 192.168.0.6 METRIC 1 IF 1
Input is validated

Command is for SDN Controller
OK !

NetSim>stop

NetSim>

9. Interpret the Results.

Figure 3-27: NetSim Console Window

Ver 14.0

a. Open Packet trace and filter CONTROL_PACKET_TYPE/APP_NAME to APP1_CBR, you

will see that data packets transmitted from Wireless Node 1 > Wireless_Node 2 >

Wireless_Node_3 > SDN Controller to Wireless Node 5 as part of the commands

executed for static route configuration.

PACKET_ID | ¥ |SEGMENT_ID ~ PACKET TYPE ~ CONTROL PACKET TYPE/APP_NAME
1558

-T|SOURCE_ID ~ | DESTINATION_ID ~ TRANSMITTER ID ~ RECEIVERID -~

Appl_CBR NODE-1 NODE-5 NODE-3 NODE-5
1559 0 CBR Appl_CBR NODE-1 NODE-5 NODE-1 NODE-2
1559 0 CBR Appl_CBR NODE-1 NODE-5 NODE-2 NODE-3
1559 0 CBR Appl_CBR NODE-1 NODE-5 NODE-3 NODE-5
1560 0 CBR Appl_CBR NODE-1 NODE-5 NODE-1 NODE-2
1560 0 CBR Appl_CBR NODE-1 NODE-5 NODE-2 NODE-3
1560 0 CBR Appl_CBR NODE-1 NODE-5 NODE-3 NODE-4
1560 0 CBR Appl CBR NODE-1 NODE-5 NODE-4 NODE-5
1561 0 CBR Appl_CBR NODE-1 NODE-5 NODE-1 NODE-2
1561 0 CBR Appl_CBR NODE-1 NODE-5 NODE-2 NODE-3
1561 0 CBR Appl_CBR NODE-1 NODE-5 NODE-3 NODE-4
1561 0 CBR Appl_CBR NODE-1 NODE-5 NODE-4 NODE-5
1562 0 CBR Appl_CBR NODE-1 NODE-5 NODE-1 NODE-2
1562 0 CBR Appl_CBR NODE-1 NODE-5 NODE-2 NODE-3
1562 0 CBR Appl_CBR NODE-1 NODE-5 NODE-3 NODE-4
1562 0 CBR Appl_CBR NODE-1 NODE-5 NODE-4 NODE-5
1563 0 CBR Appl_CBR NODE-1 NODE-5 NODE-1 NODE-2
1563 0 CBR Appl_CBR NODE-1 NODE-5 NODE-2 NODE-3
1563 0 CBR Appl_CBR NODE-1 NODE-5 NODE-3 NODE-4

Figure 3-28: Packet Trace Window

3.3 Configuring Static Routes for Internetworks using SDN

In the example the IP tables in the nodes and routers on an SDN network are maodified using SDN

CLI commands.

The network model in this example consists of the following configuration:

= A subnet with 2 wired nodes, 5 routers, and a unicast application running on one of the

wired nodes.

= SDN controller running on one of the router.

© TETCOS LLP. Allrights reserved
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= Set Transport Protocol to TCP in Application icon present in the top ribbon/toolbar. Open
Flow protocol is enabled on all wired nodes and routers.

= A unicast application set from Wired_Node_1 to Wired_Node_2.

= OSPF is the routing protocol in the routers.

= The node SDN_Controller is configured to be the SDN controller.

= Simulation time is set to 500 seconds.

= Plots, Packet trace, and Event trace is enabled.
To simulate SDN and change the IP tables:
Open NetSim and Select Examples > Software Defined Networks > Internetworks
StaticRoute then click on the tile in the middle panel to load the example as shown in below
screenshot

[ MetSim Home - a X

NetSim Professional
Network Simulation/Emulation Platform
Version 14,027 (64 Bit)

New Simulation Ctrl+N  Example Simulations Internetworks StaticRoute Results

Your Work Ctr-0 Intemetworks In the example, the IP tables in the nodes and routers on an SDM

| Eamples Cellular Networks. commands. 4 oS
Advanced Routing x

network are

e modified using SDN CLI

A —
M
Intemetworks StaticRoute 3 3

RMCBB\
y 7 6

i s
3 = (2 i,

Roliter 6

Experiments Mokile Adhoc Networks

4 Software Defined Netwarks 2
Enabled open flow in all devices 3

Changed SDN controller device name )
Transport protocol: TCP T
Static route configuration via CLI

ufer 3 SDN_Cantroller

Wired_Node_1 Wired_Node 2

I0T-WSN

Cogritive Radio Networks
LTE and LTE-A

VANETS 7

Satellite Communication
5GNR ©

TDMA Radio Networks

Type the following commands on the NetSim CLI console, in
the <Device name with Device_Id> route add <destination IP
address>MASK <subnet mask> <gateway IP address>
<metric> if <interface#> format

License Settings

Exit Alt+F4 ROUTER_3 route add 11.5.1.2 mask 255.255.255.255
11.6.1.2 metric 1if 3
Ready to simulate scenarios to understand the working of the different technology libraries in NetSim. Expand and dlick on the file name to display simulation exampies. Then click on a tile in the middie pane! to load the simulation. Click on the book icon on
the left (Example Simulations) panel to view documentation (pd).
Leamn Documentation Contact Us

Support
e Email - sales@tetcos.com
Phone - +31 767 605 4321

Website 1€05.CO

Figure 3-29: List of scenarios for the example of Internetworks StaticRoute

The following network diagram illustrates the network setup related to this example as shown
below Figure 3-30.

(A G

L) 3 L

Router 4 Router_.

2
L = 7 N

a3 = Y8
G 5 = 7 R’
Router 3 SDN_Controller Router |

g

2

Appi CBR
Wired_Node 1
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Figure 3-30: Network set up for studying the Internetworks StaticRoute

1. Click on the Application icon present in the top ribbon/toolbar.

a. CBR Application from Wired Node 1 to Wired Node 2 with 50 Mbps Generation Rate
(Packet Size: 1460Bytes, Inter Arrival Time: 233.6ps).

b. Application Start time is 30 sec.

c. Set Transport Protocol to TCP.

Plots, Packet Trace and Event Trace features are enabled.
3. Simulate SDN. To do so:

a. Click the Run button. The Run Simulation pop-up window appeatrs.
b. Simulation time is set to 500 Seconds.

c. In the Run time Interaction tab, Interactive Simulation option is set to True.

Right-click SDN_Controller and click NetSim Console.
Simulate SDN. To do so,

a. Click the Run button. The Run Simulation pop-up window appeatrs.
b. Simulation time is set to 500 Seconds.

c. In the Run time Interaction tab, Interactive Simulation option is set to True.

6. Interpret the results.

a. Open packet trace and filter the CONTROL_PACKET_TYPE/APP_NAME to APP1_CBR,
and PACKET _ID to 1. Packets reach Wired_Node_ 2 via Wired_Node 1 > Router 3 >

SDN_ Controller > Router 6 as shown in Figure 3 15.

| PACKET_IDE4 SEGMENT_ID Il PACKET_TYPE [l CONTROL_PACKET_TYPE/APP_NAME E4 SOURCE_ID Bl DESTINATION_ID Bl TRANSMITTER_ID Bl RECEIVER_IDER
0 CeR App1_CBR NODE-1  NODE-2 NODE-1 ROUTER-3

0 Cer App1_CBR NODE-1  NODE-2 ROUTER-3 ROUTER-7

0 cer App1_CBR NODE-1  NODE-2 ROUTER-7 ROUTER-6

0 CBR App1_CBR NODE-1  NODE-2 ROUTER-6 NODE-2

[ e

Figure 3-31: Packet Animation window
7. Click View Results on the tool bar, Link metrics in the left area and check the Detailed View
check box in the Link Metrics Table pop-up window. You will not see data packet
transmissions in links 2, 3, and 4 as shown in below Figure 3 16.
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Link_Metrics_Table

Link_Metrics

Packets Transmitted Packets Errored Packets Collided
Link ID  Link Throughput Plot

Data Control Data Control Data Control
All MNA 184414 184006 242 10 0 0
1 MNA 46196 45950 61 2 0 0
2 NA 0 39 0 0 0 0
3 NA 0 39 0 0 0 0
4 NA 0 40 0 0 0 0
5 MNA 46010 45957 56 4 0 0
6 MNA 46135 45988 62 2 0 0
7 MNA 46073 45993 63 2 0 0

Figure 3-32: Link Metrics table in Result Window
8. For the same example, configure static routes on Router_3 such that all traffic bound for the
11.4.1.2 subnet will go to a gateway 11.2.1.2, that is, from Router_3 > Router_4 > Router_5
> Router_6.

To configure the static routes for Router_3:

Simulate the network again.

b. Now, right-click SDN_Controller and click NetSim Console.

c. Now, the client (NetSimCLl.exe) starts and attempts to establish a connection with
NetSimCore.exe. NetSim CLI console opens.

d. Type the following commands on the NetSim CLI console, in the <DeviceName with
Device_ID> route add <destination IP address> MASK <subnet mask> <gateway IP
address> <metric> if <interface #> format. Router_3 route ADD 192.168.0.2 MASK
255.255.255.0 11.0.0.2 METRIC 1 IF 2

e. (Optional) To check the static routes on ROUTER_3, type ROUTER_3 route print. The

following image illustrates step (c) and (d) as shown below Figure 3-33.

B ' C\Program Files\NetSim\Standard_v14_0\bin\NetSimCLl.exe

Metric
1

1ee
1ee
1ee

1ee

Figure 3-33: Route added to network and route printed in command.
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9. Interpret the results.

Click View Animation and see the Packet Animation.
b. The packets reach Wired_Node_2 via Router 3 > Router_4 > Router_5 > Router 6.
c. Click View Results on the tool bar, Link metrics in the left area and check the Detailed

View check box in the Link_Metrics_Table pop-up window.

You will see data packet transmissions in Links 2, 3, and 4.
The following figure illustrates step (7c¢) as shown in below.

Link_Metrics_Table

Link_Metrics

Packet_transmitt.. Packet_errored Packet_collided

Link_id Link_throughput_piot Bytes_transmitted(bytes) Payload_transmitted(bytes) Overhead_transmitted(bytes)

Data ontrol Data Control Data Control

Al NA

Link throughput

(&

65 4382
4
4 0
4

98

474
474
473
472
472

Figure 3-34: Link Metrics Table
d. In the simulation results window click on the Open Packet trace option in the left area.

Once the packet trace opens, apply display filters to the

CONTROL_PACKET_TYPE/APP_NAME column to show only
OPENFLOW_COMMAND and OPENFLOW_RESPONSE packets.
You will see that OpenFlow packets flow between Router_3 to SDN_Controller.
10. In Router_3 under appilication layer use routing protocol as RIP

11. Configure static routes for Router_3 as follows:

a. Simulate SDN (Refer step 4).
b. Right-click SDN_Controller and click NetSim Console.

Now, the client (NetSimCLl.exe) starts and tries to establish a connection with

NetSimCore.exe. NetSim CLI console opens.

c. Type the following commands on the NetSim CLI console, in the <DeviceName with
Device_ID> route add <destination IP address> MASK <subnet mask> <gateway IP

address> <metric> if <interface #> format.

ROUTER_3 route add 11.5.1.2 mask 255.255.255.255 11.6.1.2 metric 1 if 3

12. Interpret the results.

a. Click View Animation and see the Packet Animation. The packets reach Wired_Node 2

via Router 3 > SDN_Controller > Router_6.
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3.4 Configuring Static Routes for a WSN Network by using

SDN

In this example static routes are configured in sensors using SDN commands executed in a SDN

controller.

The WSN network model in this example consists of the following configuration:

= A subnet with 5 wireless sensor, 1 ad-hoc link, 1 wireless sink node, and a unicast sensor

application running on one of the wireless sensors.

= One wireless Sensor is configured as the SDN controller.

» A unicast application from Wireless_Sensor_1 to Wireless_Sensor_5.

=  Simulation time of 500 seconds.

= Packet trace is enabled.

To simulate the example for WSN using SDN:

Open NetSim and Select Examples > Software Defined Networks > WSN StaticRoute then

click on the tile in the middle panel to load the example as shown in below screenshot

[ NetSim Home

NetSim Professional
Network Simulation/Emulation Platform
Version 14.0.27 (64 Bit)

New Simulation Crl+N  Example Simulations

Your Work Ctrl+O Internetworks

e Cellular Networks
Advanced Routing
Experiments Mobile Adhoc Networks
4 Software Defined Networks
4 Configuring SDN
SDN Intemetworks
WSN Setting Multiple SDN Controllers
MANET StaticRoute
Intemetworks StaticRoute
TOT-WSN
Cognitive Radio Networks
LTE and LTE-A
VANETs

WSN StaticRoute

In this example, static routes are configured in sensors using SDN commands executed in an SDN controller.

WSN StaticRoute

Enabled open flow in all devices
Changed SDN controller evice name
Transport protocol: UDP

Static route configuration via CLI

Results
> =
= 1=
Wireless Sansor_1 @ Nbeless
o1
SONY, Conrd
<t x4
e >3
2 Adoc Link 1 Wireless_Sen:

Type the following commands on the NetSim CLI
console, in the <Device name with Device_Id> route add
<destination IP address>MASK <subnet mask>
<gateway IP address> <metric> if <interface#> format.

Wireless_Sensor_1 route ADD 11.1.0.0 MASK 255.255.0.0 11.1.1.4

METRIC 1IF 1

SDN_Controller route ADD 11.1.0.0 MASK 255.255.0.0 11.1.1.6

METRIC1IF 1

Ready to simulate scenarios to understand the working of the different technology libraries in NetSim. Expand and click on the file name to display simulation examples. Then click on a tile in the middle panel to load the simulation. Click on the book icon on

Satellite Communication
5GNR
TOMA Radio Networks
License Setting;
Exit Alt+F4
the left (Example Simulations) panel to view documentation (pdf).
Support Learn

Contact Us

Email - sales@tetcos.com
Phone - +91 767 605 4321
Website

Figure 3-35: List of scenarios for the example of WSN StaticRoute

The following network diagram illustrates the network setup considered in this example:
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& 5

Wireless_Sensor_2

-
= 3 App1_SENSOR_APP - '3@

SinkNode_6

Wireless_Sensor_5

Wireless_Sensor 4

Figure 3-36: Network set up for studying the WSN StaticRoute

1. The following settings are done in the application layer properties of the devices for

configuring SDN:

Device Name _
Wireless_Sensor_1 | Enable
Wireless_Sensor_2 | Enable
SDN_ Controller Enable
Wireless_Sensor_4 | Enable
Wireless_Sensor 5 | Enable
WSN_Sink 6 Enable

Open_Flow

FALSE SDN_Controller
FALSE SDN_Controller
TRUE NA

FALSE SDN_Controller
FALSE SDN_Controller
FALSE SDN_Controller

Table 3-4: Set the properties for all the devices

2. Click on the Application icon present in the top ribbon/toolbar.

a. Sensor Application from Wireless Sensor 1 to Wireless_Sensor 5 with default
Generation Rate (Packet Size: 50Bytes, Inter Arrival Time: 1000000us).
b. Set Transport Protocol to UDP.

3. Before Simulating the scenario, Right-click SDN_Controller and click NetSim Console. Now,

the client (NetSimCLI.exe) waits to establish a connection with NetSimCore.exe.

a. Enable the packet trace and click on the Options tab. Select Run time interaction.

ﬁ File  Options Help | Network: Internetworks | Workspace: 30ct2023

5% Create| Open MATLAB Interface

Run Time Interaction

(3 seve e v

11l Configure Reports % Show/Hide Info

Wired Node <3| L2 Switch
T, ® = &
<—:] Close \Z/ E Wireless Node * L3 Switch

File Run Simulation

Node Switch Access Point Router

N

‘0

Wired/Wireless Links

Figure 3-37: Runtime Interaction in GUI

b. In the Run time Interaction tab, Set the Interactive Simulation option as True and click on

OK.
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NetSim allows users to interact with simulations at runtime via command execution to
view/modify certain device parameters during runtime.

There are two options available for runtime interaction. Interaction can be set to be via a
socket or through a ‘input.txt’ file in a predefined format.

This input.txt file accepts all the commands that NetSim's interactive simulation supports.

Interactive Simulation True -

File Name Input File Browse

OK Cancel

Figure 3-38: Runtime Interaction Window

c. Click on Run simulation window and simulate it to 500 sec.

T NetSim - Run Simulation

Simulation Time
Enter desired simulation time. Valid range is 0.0001 to 100,000 seconds.

Simulation Time | 50|

Seed Value
Enter seed value between 1 to 99,999,999. The seed values are used to generate random

numbers in simulation.

Seed 1 12345678 Seed 2 23456789

Run Cancel

Figure 3-39: Run Simulation Window

Ver 14.0

Simulation (NetSimCore.exe) starts to run. NetSimCore.exe displays the following message:

waiting for the first client to connect.

d. Simulation (NetSimCore.exe) starts to run. NetSimCore.exe displays the following

message: waiting for the first client to connect.
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rlm_hw>11:
from

may take upto 2 min) -

1111111111
path- C

e upto 2 min) -

AppData\Local\Temp\NetSim\std_14.8\/log directory. Error

Data\\Local\Temp\NetSim\std_14.8\Plot_*

to connect. Press ctrl+c to stop connection.

number 17

Figure 3-40: Waiting for Client to connect.

Ver 14.0

4. Observe the packet trace after simulation, you will see the direct communication between

wireless sensor 1 and 5.

PACKET_ID ~ |SEGMENT_ID| ~ PACKET_TYPE -~ |CONTROL_PACKET_TYPE/APP_NAME -Y|SOURCE_ID| - |DESTINATION_ID - TRANSMITTER_ID| ~ |RECEIVER_ID ~

1

0N O U R WN

0 Sensing
0 Sensing
0 Sensing
0 Sensing
0 Sensing
0 Sensing
0 Sensing
0 Sensing

Appl SENSOR APP
Appl SENSOR APP
Appl_SENSOR_APP
Appl SENSOR APP
Appl SENSOR APP
Appl SENSOR APP
Appl SENSOR APP
Appl SENSOR APP

SENSOR-1
SENSOR-1
SENSOR-1
SENSOR-1
SENSOR-1
SENSOR-1
SENSOR-1
SENSOR-1

SENSOR-5
SENSOR-5
SENSOR-5
SENSOR-5
SENSOR-5
SENSOR-5
SENSOR-5
SENSOR-5

SENSOR-1
SENSOR-1
SENSOR-1
SENSOR-1
SENSOR-1
SENSOR-1
SENSOR-1
SENSOR-1

SENSOR-5
SENSOR-5
SENSOR-5
SENSOR-5
SENSOR-5
SENSOR-5
SENSOR-5
SENSOR-5

Figure 3-41: Direct communication between node 1 and node 5 in packet Animation window

5. For the same example, configure static routes such that the packets will go through

Wireless_Sensor_1 to Wireless_Sensor_5 via SDN_Controller. To configure the static routes

on SDN_ Controller for Wireless_Sensor_1

e. Follow the above step 3 as explained above

6. Type the following commands on the NetSim CLI console, in the <DeviceName with

Device_ID> route add <destination IP address> MASK <subnet mask> <gateway IP

address> <metric> if <interface #> format.

Wireless_Sensor_1 route ADD 192.168.0.6 MASK 255.255.255.0 192.168.0.4 METRIC 1 IF 1
SDN_Controller route ADD 192.168.0.6 MASK 255.255.255.0 192.168.0.6 METRIC 1 IF

7. Interpret the results.
Open Packet trace and filter the CONTROL_PACKET_TYPE/APP_NAME to show only

APP1 SENSOR_APP, you will see that data packet flow from wireless sensor 1 to wireless

sensor 5 through SDN Controller.
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PACKET_ID ~ |SEGMENT_ID |~ |PACKET_TYPE ~ CONTROL_PACKET_TYPE/APP_NAME

Ver 14.0

¥ SOURCE_ID | ~ | DESTINATION_ID | - | TRANSMITTER_ID |~ |RECEIVER_ID ~

9 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
10 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
11 0 Sensing Appl SENSOR APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
12 0 Sensing Appl _SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
12 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
13 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
13 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
14 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
14 0 Sensing Appl _SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
15 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
15 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
16 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
16 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
17 0 Sensing Appl _SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
17 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
18 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
18 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
19 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
19 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5

Figure 3-42: Communication between node 1 > SDN Controller > node 5 in packet Animation window

4 Latest FAQs

You can refer to the up-to-date FAQs about NetSim’s SDN library at

https://tetcos.freshdesk.com/support/solutions/folders/14000122307.
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